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Course Description

QAD designed this course to cover the basics of using the QAD Enterprise Applications Standard
Edition (SE) and Enterprise Edition using the .NET UI.

The course includes:
« Anintroduction to the QAD .NET UI.
« Navigating the .NET UlI.
- Application help options.
« .NET Ul programs
 Basics of Browses

Students will also learn by labs designed to reinforce concepts presented in this training guide.

Objective

Learn how to navigate both the Enterprise (EE) and Standard (SE) editions of QAD Enterprise
Applications. In addition, studentswill be able understand the help options, different programs and
be able to use browses effectively.

Benefits

Students will become more efficient in the use of QAD Enterprise Applications.

Audience
- Implementation consultants
« Members of implementation teams
« Key users

Prerequisites

« Some familiarity with Enterprise (EE) and Standard (SE) editions of QAD Enterprise
Applications

Course Credit and Scheduling

This course is designed to be taught in two days.

Virtual Environment Information

The hands-on exercises in this book should be used with the “ Standard Edition rO1 - Training”
environment, in the “Training” workspace.

MQAD



QAD Resources

If you encounter questions or problems on QAD software that are not addressed in this book,
several resources are available.

Product Help

All QAD products ship with integrated help systems. including Character Ul Help, .NET Ul Help,
QAD Assist, and QAD Guide Me help. In addition QAD has extensive Web Resources

The QAD website provides product and company overviews.
http://www.qgad.com/

From QAD’s main site, you can access QAD’s Learning or Support sites.

QAD Learning Portal for Training Opportunities

To view available training courses, locations, and materials, use the QAD Learning Portal. Choose
Learning under the Global Services tab to access this resource.

QAD Support for Product Documentation and the QAD Knowledgebase

To access release notes, user guides, installation and conversion guides by product and release,
visit the Support website. Support als20 offers an array of tools depending on your company’s
maintenance agreement with QAD. These include the Knowledgebase and direct links to QAD
Support experts.

Choose Support under the Global Services tab.

Any QAD customer can register for a QAD web account by accessing the Support web site and
clicking the Accountslink at the top of the screen. Your customer ID number isrequired. Accessto
certain areas is dependent on the type of agreement you have with QAD.

MNQAD
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Objective

Chapter Objective
« Students will infroduced to the following in
the QAD .NET UI:
- The different types of Ul mode in QAD
Enterprise Applications
- Attributes of component-based and non-
component based programs

- The QAD .NET Ul Login window

MQAD
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Benefits

Chapter Benefits

« Students will understand the following in the
QAD .NET Ul:

- The different Ul modes available in QAD
Applications

- The different atiributes of component-

based and non-component based
screens

- How to log in to the QAD .NET Ul

MNQAD
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Training Flow

Training Flow

Infroduction
Navigation

« Application Help

« Programs
Browses

- Character

MQAD
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Introduction

Introduction
« The QAD .NET Ul

- Microsoft Technology
* Incorporates familiar Ul features
* Reduces learning effort by users
One inferface, two modes
* QAD .NET Ul
* Terminal Mode (rendering of Character Ul)

MNQAD
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Character Ul

Character Ul

P 172.16.28.81 - PuTTY o
s

QHI : gaddb-

mfmenu Hain Menu 05/26/10
1. Items/Sites 13. Product Structures 25. General Ledger
2. Addresses 14. Routings/Work Center 26. Multiple Currency
3. Inventory Control 15. Formula/Process 27. Accounts Receivable
4. Warehousing 16. Work Orders 28. Accounts Pavable
5. Purchasing 17. Lean Hanufacturing 29. Tax Hanagement
6. 18. Repetitive 30. Cost Management
7. Sales Orders/Invoice 19. Quality Hanagement 31. Banking/Cash Momt
. Configured Products 20. Product Line Plan 32. Fixed Assets
9a Z1. Resource Plan 33. Enterprise Ops Flan
10. 22. Forecast/Haster Plan 34.
11. Service/3Support 23. HMaterials Rgmts Plan 35. EDI eCommerce
1Z. Distribution Plan 24. Capacity Rgmts Plan 36. System Admin

Please select a function. F4 or blank to EXIT .

Fress F2 for Help ™

Unlike the QAD .NET user interface, the character user interface depends completely on input
from the keyboard. Because it is not a graphical user interface, all navigation is based on:

» A command-prompt interface to execute programs
« Combinations of keystrokes to issue commands within programs
« Navigation without use of a mouse through the UNIX character interface.

Component-based functions are accessible only through the QAD .NET UI. You cannot access any
of these functions from the Character Ul.

MQAD



Introduction to QAD .NET Ul 11

Terminal Mode in the QAD .NET Ul

Itern Master Maintenance |

Terminal Mode in the QAD .NET Ul

Fromo Group:

Ttem Number: [ Description:
Unit of Measure:
Item Data
Prod Line: Item Type: Drawing:
Added: Status: Revision:
Design Group: Group: Drawing Loc: Size:

Price Break Category:

ABC Class:
Lot/Serial Control:
Site:

Location:

Location Type:
Auto Lot Numbers:
Lot Group:

Article Number:

Mo

Item Inventory Data

Average Interval:
Cycle Count Interval:
Shelf Life:
Allocate Single Lot: No
Key Item: No
PO Receipt Status:
WO Receipt Status:

Memo Order Type:

Rctive: No
Active: No

With the QAD .NET Ul interface, you can still use non-component based programsin a CHUI
interface. You do this by selecting Terminal Mode in the Program Properties option. Thisis
described in the section on Programs.

MNQAD
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Attributes of Component-Based Programs

Aftributes of Component-Based Screens

- Underlying Microsoft.NET Technology

 Traditional Windows screen navigation

- Familiar click and point functions
Right-click options

MQAD
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Component-Based QAD .NET Ul Screen

Component-Based Screen
Journal Entry Create *
4 GoTo ~ Actions ~ % Tools »| # Attach | & Print s Preview
Attachments )
Yo d | 08 Pasting Diste oa/30200 -
Dapbook Code » |¢| DDODDOCOO Save As Template
Descrption Template Code Replacemant
Orignal Posting 000000000
Felerence
GL Account 4 GLDescription ¢ SubéccountC 4 CostCe ¢ Description ¢ Trans 4 TC Detat [ TC Credit ¢ Intercompary Code ¢
L4
4| i »
CutencyView  [Tiansacton Curency  » Tl TC 000 000]
Saveand Create “ Close

You use traditional mouse-clicks, tabs, and keyboard tabbing to navigate the component-based

screen.

MNQAD
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Attributes of Non-Component Based Screens

Aftributes of Non-Component Based Screens
A rendering of the Character Ul for the .NET
Ul
Similar tabbing and keyboard navigation

Screen navigation bar for some non-
component based screens
- Enabledin Tools | Options

Non-component based screens are based on traditional procedural-written Progress-based
technol ogy.

MQAD
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Non-Component Based QAD .NET Ul Screen

Non-Component Based Screen

[Sales Order Maintenance -
# GoTo ~ Actions ~ Copy ~ 5 Print s/ Preview & Aftach
Sales Order (»)  Drder.
Header Lines
> Header » 4 » > > > [
Header
Oider || Sold-Te Bil To Ship-To
Sold-Ta Ship-Ta
Details
Order Date: Line Pricing: Confirmed:
Required D ate: Manual Currency: Language:
Fromise D ate Daybook Sel T anable
Due Date: Channel Fised Pnce;
Perform D ate: Project: Credit Tems:

All Standard and Enterprise Edition programs are non-component based, except QAD Enterprise
Financials.

MNQAD
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Login Menu

Login Menu

Login |

FIQAD

Enterprise Applications

User. \ |
Pazsword: | |

Log on to: i_gadui - |

Starting the QAD .NET Ul

To launch the client, select the QAD Applicationsicon or Menu item under Programs on the Start
Menu. Enter your assigned user and password if assigned. Select a system environment for which
you have permissions from the drop-down menu.

MQAD
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Summary

Chapter Summary

- There are different types of Ul mode within
the QAD .NET Ul

- Component and non-component based
screens have different visual and navigation
afttributes

+ You launch the QAD .NET Ul from a menu
option or desktop icon and select an
environment from the drop-down menu

MNQAD
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Exercise and Knowledge Check

1 You can use the mouse for certain functionsin Terminal Mode. (T/F)

2 Some component-based functions are configurable in Terminal Mode. (T/F)

3 Which of the two interfaces depends completely on input from the keyboard?
4 Which Enterprise Edition application is component based?

MQAD
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Objective

Chapter Objectives

« Learn about the different ways of navigating
in the QAD .NET Ul.

MQAD
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Benefits

Chapter Benefits

« You willbe able to navigate the different
types of screens and programs within
Enterprise Applications.

MNQAD
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Training Flow

Training Flow

INnfroduction
Navigation

« Application Help

« Program Types
Browses

« Character Ul

MQAD



Navigating the QAD .NET Ul 23

Workspace Screen

Workspace Screen

File Edit Tools ‘Workspace Wind Help = hMainmenu bar

¥ Applications

Menu search for progrars,

l browses, and other menu items

# |7 Collections

+7) Metrics

# {7 Customer Management
# {5 Supply Chain

#HY) Manufacturing

#{7) Financialz

+ {5 Master Data

#(7) System Administration

— A pplications Ared

| ¥

%y Sales Order Maintenance
%y Purchase Drder Maintenance

«—— =+ Favorites Areq

PRI

& Ouick Search

Slatowih - = Quick Search Field
# ¢ Items .
& & Sakes order and fems «— Browse Groups

| w|

Workspace Screen
- Main menu bar. Includes file, edit, tools, workspace, window and help.
» Menu search. Locates screens.
Application area. Displays the applications that are available in the QAD .NET UI.
Favorites area. Lists fequently used screens.
» Quick search area. Search for avalue across all of the fields in the browse.
Browse Groups. Creates groups of browses for quick search purposes.

L]

MNQAD
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File Menu

File Menu

File = Edit Tools ‘Workspace ‘window Help
Logoif

o Fage Setup
» Print Preview

lga Print Ctrl+F

1 USa USA-Demo [USD] » USA-01 US4 Primary Entity f Home Page
2 Qa0 Systern Domain [IUSD] > 9949 - 5v'540M f Home Page

Ezit

The File menu commands include:

« Logoff/Login. Log off from al applications running in the QAD .NETUI. You can login as a
Separate user is security allows.

» Page Setup. Defines print output for browses. This has no impact on maitenace programs
* Print Preview. Generates a print preview of abrowse prior to print.

» Print. Open the print dialog so that you can print the datafor a browse or the screen for other
programs.

» Program History. The section below Print displays the last six programs that you have opened.
You can choose to open one of these programs directly from this pull-down menu.

» Exit. Close the QAD NET Ul and log off any open applications.

MQAD
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Edit Menu

Edit Menu

File Edit | Tools ‘“Workspace ‘Window Help

B » o v [
| tani 53 Copy Ctrl+ |
B [ Paste Crl+y

lm |z|

‘*‘ o] % Menu Search Crl+h
FHE cwswmer managsmern

{7 Supply Chain

) Manufacturing

[#H7) Financials

17 Master Mata

[al

m

The Edit menu commands include:

- Cut, Copy, and Paste. These are standard Microsoft commands. View associated shortcuts on
the screen above.

« Menu Search. While In any screen you can immediately go to Menus search by using the
shortcut Ctrl + M or select menu search.

MNQAD
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Tools Menu

Tools Menu

File Edit Tools  ‘“Workspace ‘Window Help

Options... -|__f_|

[l Internet Properties

T [

7 Collecti 5] Delete Histony

i Metics IManage Workspaces
) Customcr managsmesn

1 Supply Chain

1 Manufacturing

7 Financials

+ Options. View administrative information and set personal options for browses and other
application settings. For more information, see next dlide Settings the user cannot configure
are viewable from Help|View Configuration.

« Internet Properties. Update the same settings that display when you select Internet Options
from the Tools menu in Internet Explorer.

» Delete History. Delete the following data Temporary files: Internet Explorer cache and |E
cookies, and cached resources created for the current configuration.Session information: the
graphical state stored by the GUI persistence manager. Also deletes user input, such as last
configuration, last workspace, most recently used menu items, and credentials.

» Manage Workspaces. Activate and deactivate workspaces from alist and reorder them.

MQAD
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Tools — Options

Floptions =X
E Browse It
Cancel transaction on drill change True 1
E Cell Font Microsoft Sans Serif, 8.25pt
Link Font Color M elu:
Row alternating Color |:| 235, 235, 235
Row Backaround Calar |:| White

Rows Per Page
El Desktop
Auto advance on the last data field
E Cell Fant
Prompt user on open transaction
Sereen Navigation Bar
‘Text' Report Font
Ul Extensions
El General
Allow Multiple Applications
Left Mavigation Panel Style
Show Workspace Selector

(= TP T

100

False

Microsoft Sans Serif, 8.25pt
True

True

Lucida Console, §.25pt
True

True
Studio Toolbasx
True

5]

Allow Multiple Applications
If this value is set to true, then multiple instances of the application can be launched.

=

Field Descriptions

Cancel transaction on drill change. On a maintenance screen, you can then use the up and
down arrows on the keyboard to select next item from an attached |ook-up browse. If trues the
capability istrueif false then the next item will not populate.

Céell Font. Specify standard windows font name, style, and size to use for cell data values.

Link Font Color. Choose the color to use for hot-linked data values. You can choose system
colors, Web colors, or custom colors from acolor palette

Row Alternating Color. Specify the background color for every other row in the browse
display.
Row Background Color. Specify the background color for data rows in browses.

Rows Per Page. Specify the number of data rows to retrieve for each browse page of datain
the browse. The default is 100.

Desktop Auto advance on next datafield. Specify whether to go to the next frame after leaving
the last field in the current frame.

Cell Font. Specify the font name, style, and size to use for cell datavalues. Thisfield displays
a standard Windows font dialog where you can select afont, font style such as bold or italic,
and font size.

MNQAD
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« Prompt user on open transaction. When you close a program that has a transaction running,
you can have the QAD NET Ul prompt you to double-check whether you want to close the
program.

 Screen Navigation Bar. To help you navigate complex screens, the QAD NET Ul includes a
navigation tool for selected programs. This option specifies whether to include the screen
navigation bar when displaying selected programs.

 Text Report Font. Specify the font in which reports are displayed when output to text.

« Ul Extensions. Specify whether to include additional Ul extensions such as enhanced button
labels.

« General Allow Multiple Applications. Specify whether you can launch multiple instances of
the QAD NET UlI.

- Left Navigation Panel Style. Specify the appearance of the left navigation panel, which
includes the Applications Pane, Favorites Pane, and Role Menu Pane. .

 Enable Home Page. Specify whether the home page displays in the Home Page tab when you
login.

« Internet Properties. Update the same settings that display when you select Internet Options
from the Tools menu in Internet Explorer.

« Delete History. Delete temporary files, session information, user preferences, and log file data.

MQAD
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Workspace Menu

Workspace Menvu

‘wWorkspace | Window Help
CAM Canada - Demo [CAD] » CAN-01 Canada
CHINA China-Dema [CNY] » CHINA-DT CHINA-D1
EMEAEMEA [EUR] > Germany Germany
FRA France - Dema [EUR] » FRA-D1 France
FRA France - Dema [ELIR] » FRA-DZ entité france 02
WEX hexica - Demo [MXM] » MEX-01 hMexico
QAD Systern Dormain [USD] > 999 - SYSADKM (1)
Train Puerto Rica - Demo [USD] = Entity © S5k Training Entity
Train Puerto Rica - Demo [USD] = Training Entity Far Training
UK United Kingdom [GBF] > UK-01 UK-01
LISA USA - Demao [USD] > Conzol-01 Conszolidation 01
LISa USA -Demo [USD] > US-4 USa-4

v USAUSA-Demo [USD] > USA-0T LISA Primary Entity (1)
U5A USA-Dermao [USD] » US-B LISA-B

Mare ...

Manage Workspaces. Activate and deactivate workspaces from alist

A workspace typically represents a domain. When you exit the QAD NET Ul, the active
workspace is saved and displays when you log in again.This allows you to change domains by
selecting from the list. The check mark signifies the domain that is currently active. You can
also change your workspace from the Workspace Selector along the bottom of the QAD NET
Ul window. In The SE edition you login to the default domain as defined in user maintenance.

MNQAD
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Window Menu

Window Menvu

File Edit Tools ‘“Workspace Window Help
Cloze All Windowes
2 ance |Furchase Order haintenance %
| h d ink 1 Sales Order Maintenance ! . :
EuIchase oL manen = ions ‘I L Copy '| @ Print & Previe
% Purchase Order Maintenance v 2 Purchasze Order Maintenance
Header Lines 71
> Header B | P Tax B Delive
Header
Purchaze Drder'“ ,»'-_"| Supplier:
ol
: Supplier
Select your favorite application from the
Applications menu and drag it into this :
window to save it ;
1
Details
Order D ate: Price Thi:
s

This menu displays the programs in the order in which they were opened. Close al windows shuts
all screens on the workspace.
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Help Menu

File  Edit Tools ‘Workgpace Window Help

®

1 Applications

[ Application Hel =
| customer m @ Applicstion Help bions = Ll copr ,&
&, - — o . -
:‘ Customer Madify @ View Configuration
5 Blocked Custamer Maintenance .
%‘% Controlled Customer Maintenance @ About
Suppliar:”
Name:
Address:
3 Address:
: Address:
Select your favorite application from the City:
applications menu and drag it into this
window to save it Covintry:
itention;

Search

hance !Furchase Order

Use the Help menu to display Application and Program Help, and to view installation and

application configuration details.
The Help menu commands include:

Search. This option displays the QAD Assist

default search page.

Application Help. This option is available when your cursor is placed within a non-component

based field or screen. When you then select A
displayed for the field or screen.

pplication Help, field or procedure help is

View Configuration. Opens awindow that displays various configuration settings that cannot
be directly changed by a user of the QAD .NET UI. These settings must be changed by a

system administrator.
About. Display information about the version

of QAD .NET Ul that is running, the time the

QAD .NET Ul was started, and the total amount of physical memory the QAD .NET Ul is
using. (If N/A isdisplayed, the operating system isnot giving the QAD .NET Ul permission to

access system information.)

MNQAD
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Applications Area

Applications Area

File Edit Tools ‘Workgpace ‘window Help
File Edit Tools Workspace Window Hel, -_————

'1:; .ﬂ.pplicéfiunn:;

4} Applications

Click folders to operr— || @1
) Metncs

(= Customer Management

. =% Sales Orders/Invoices
Double click on arny—s B 5 aies Gicei M

program o open ‘o Sales Order Maintenance
F@ i Adraiaion [ Sales Oider Browse
56 Damo [ Sales Drder Print
% (3 Admiristiaion ] Sales Dider Viewer
=5 Sales Drder Confirmation
=) Sales Dider Manual Allacations
|E| Sales Dider Auto Allocations
[ Available Kit Quantity ta Ship
|=5| Sales Order Repricing [ ',|
[e] ] [ |

5 Processes

Select your favorite application fram the
Applications menu and drag it into this
window to save it,

The Applications area displays the menu items for the QAD applications running inthe QAD NET
Ul. When the system is installed, the default menu organization is automatically loaded. Multiple
screens can be open at any one time Menu Search

« Find programs based on one or more menu label keywords, program name, or menu number.
For example, enter sales to display all menu labels that include the word sales.

» Execute a specific program based on full menu label, program name, or menu number. For
example, enter Item Master Maintenance, ppptmt.p, or 1.4.1 and then press Enter to display
Item Master Maintenance.

» Execute a specific program based on a shortcut defined in the Name field of Menu System
Maintenance.

» When typing in the menu search area different sceens appear as the typing continues untill the
proper screen islocated. Thisiscalled predictive text.
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Properties

File Edit Tool: ‘Workspace ‘Window Help
ki =

I
(7.1 x] ‘
N e e s | | S
EJ 7111 Ly Find in Menu

I=EARK Sales Order Cost Revalu) (5 Add To Favorites
%7113 Sales Order Credit Maint e

@7.1.14 Sales Order Credt Inquin 2

B 7115 Sales Order Credit Repor Design

|;| 7116 Sales Order Auto Credit Praperties I
= EANE Sales Order Auto Credit &, T

Ga7 118 Fernnlatad G alas Ardar Palate |"||

Al Gt wa

%y Sales Order Maintenance
% Purchase Order Maintenance

Right-click any
program and
select
properties

The Properties window includes two tabs, General and Program.

MNQAD
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Properties Options

Properties Options
% Sales Order Maintenance Properties E "é@ Sales Order Maintenance broperﬁés
General | Program General | Program
i) .
"'.-"-'3"‘ Sales Order Maintenance Domain:  GM35 EMEA - Dema [ELR]
s
Program:  sosomtp
URL:  gadsh://menudinvoke?menu-key=a 1Emenuite LI Template:
Key: 711 Desktop Wersion:  2.10.90.59
Aliases: 711, sosomlp Progrom Wersion: [AD Enterprise Applications 2010,
Merw;  Customer Management NC] mes Oﬁd
MUrmiber Open with: ED;SHUD B
Deskiop |
Tearminal
Select Terminal
OK | | Cancel | I QK | I Cancel J |

Generd:
* URL. The QAD Shell URL for the program.

* Key. The program number. For example, 7.1.1 is the program number for Sales Order
Maintenance.

« Aliases. The program number and name. For example, for Sales Order Maintenance, 7.1.1is
the program number and sosomt .p iSthe program name.

« Menu. The menu item folder location.

Program:

» Domain. The current working domain and domain currency. If the specific program updates
datathat appliesto all domains.

« Program. The program name. For example, sosomt .p isthe program name for Sales Order
Maintenance.

- Ul Template. If the user executing the program has been assigned a Configurable Screens
version of the program, the name of the assigned Ul template displays.

 Desktop Version. Version details for Desktop.
» Version. Product system version details.
+ Open with. Desktop or Terminal.
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Program Screen in Terminal Mode

Program Screen in Terminal Mode

l Sales Order Maintenance x|
order: ! Sold-To: Bill To: Ship-To:
Sold-To Ship-To
r
F Order Date: Line Pricing: No Confirmed: No
Required Date: Manual: Currency: Language:
Fromise Date: Daybook Set: Taxable: No
Due Date: Channel: Fixed Price: No
Perform Date: Project: Credit Terms:
Pricing Date: org Inv: Site:
Purchase Order: Credit Terms Interest %:
Femarks: Reprice/Edit: No
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Program Screen in Desktop (Ul) Mode

Program Screen in Desktop (Ul) Mode

Sales Oider 5010269 )  Order5010269 &) SodToB-CU4000 & Bl TaB-CL4000
Lines  Trailes
> ¥ LineDetaks > b T >
Heades
Order. 010269 Sokd-Te: B-CU4000 LnFor: Single Oig:
Sales Dider Line
Ln ltem Mumber Oty Oidered UM List Prica Discount Net Price
130100 10000 LT 100,00 0o 100.00
Line Dietails
Desc: Standard Coolant Sales Acct| 4000 || Mech e 4
Loc: | A Sie US4 DiscAcct| 4200 | Mech Jel 2 B
usD Cost 0.00 Coriimed Credit Tems Int: 00
Lot/Senst Pel Requied 6102010 = Ship Type: -
Qy Abocaled 00| Promized: 610/2010 UM Corvvession: 1.0000
Qly Picked: 00 DueDate: 6/10/2010 = Consume Fest ¥
Oty Shippad: ao Peiform Diate: - Detad Alloc:

Here we contrast the QAD .NET Ul with the more traditional Terminal version in the prior screen.
Use point and click, tab, Next, Back or Header, Lines and Trailer Tab to navigate in the non-
component based QAD.NET UI.
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Favorites

Favorites

File Edit Tools ‘Workspace ‘window Help Righ‘l‘_c”ck O

lil Sales
JI: program and select

|57 x|

kS0 Purchase Order Maintenance e 5

51.9.257 Process Data Maintenanc| (3 Find in Menu Ad d 'I' F 'I'

257 Commiszion Detail Browse ,_-,\'% Add To Favorites «—f—M—— o O Vo r | e S 4 or
“":‘ 2157 Log Charge Pending Invai

BJE? UM Graup by lter Numbe Open drOg Ond drop

sb 4257 Hanging lad_det Repart | Design

& : : : :

Smb657.1 Ship Delivery Time Mainte = 'I' 'I' h

[$557.2 Ship Delivery Time Inquin| FrePeti=s. p ro g rams 10 e

m{} 5.5.7.4 Supplier Cantrols Maintenance =l

ié(f: 5.5.7.6 Supplier Planning Schedule Maint F O \/ o ri 'I' e S O re o
;5577 :

Supplier Shipping Schedule kaint :
[ARR713 Shin Srhedule Warance Comnare Y_l - B

. Programs that are

used frequently so

that a search is not
required

E ﬂ'{,} Sales Order Maintenance
i ‘{‘2“: Purchase Order Maintenance E
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Switching Domains

Switching Domains

T
Procasses ¥ | Galns Oudes Corfimaton *

® GaTo s o Actans *| . Cepy *| 55 Piet s Preview | Adach

Sabes Ore ® Te W sasls -]

S e |
adTa

T
™
Custorves Class. Ta
ShoTa T
Order Dt T
s D T
som T
Abocae ¥
Charnge D Danesfor 41F Erdorcmere Wiamnge:
Dhursge [ D b ATP Erbicomtard Encer
Chrgn Promsia Dt
Ure Standard ATP wher AP ATP in Ul

Oume
Bach D

With the workspace selector toolbar along the bottom of the screen, you can quickly change
workspaces and domains.
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39

Sales Order Maintenance hh:.m hMaster Maintenance Xl

i B new Horizontal Tab Group

Horizontal and Vertical Tab Groups

Purchaze Order: -\

Supplier

‘M GoTo - | # amach
e [T Mew Yertical Tab Group
. Close
Item  Planning  Fri = .
9 | Gales Order Maintenance X
B ltem P ltemi Close all g
Item Close Qther: Iouu. Eous Sold-Te: CEI0D  Bill To: CE400  Ship-To: CE4ODD
Item Mumber ] Move Tab tc SaldTe ShipTe
. T Leex Bike Civy Leec Bike City
Unit of Measure: Wizichsvzasse 67 Vizichsrzasse €3
Lase 26789 Lusz 26749
i ltem Data ol il
! |Purchase Order Maintenance X L Ozder Dare: O8/2L/07 Line Pricing: Yes Condizmed: Ves 082107
4 . Fequized Dame: 06/28/07 Hansal: Cazeency: DUR Language
| GoTo ™ Actions | | Co| [ Promize Dase: Daybeosk Sew: SLS Taeable: Yor #
T . ’ Due Dame: 08/28/07 Channel Tixed Price: Yes
Purchase Order Perfors Dame: Frojecn: Credin Tems: 500
. Pricing Dawe: 08/20/07 frg Irow Siee: EME}
govay Lincs [Puzchase Order: Credin Temms Inveresn 3 0.0C
P Header P Dcioie B T 1 Bemazks: Beprice/Tdis
Header

FL=is 2=Help 3=Ins 47Bnd 7=Recall §=0lear 9=Pcev L0=Neae

Hem Master Maintenance Xi

W GoTo "
Item:

llem  Flanning  Price

> ltem > L4
Item

Itern Number

Uret of Measue

Item Data
Piod Line:
Added
Design Group:

Frome Group:

Ikem lewentory Dala
ABC Clans
Lot/Sensl Contiot
Ste

Acions *| . Copy *| (0 Print A Preview | # Atiad

() ltem Nusnber

Item Type:
Status:

Gioup:

Cyele Couy

Horizontal and Vertical Tab Groups. There are two methods or views of making multiple screens
appear on the desktop. This works especially well with the NET Ul browse programs.
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Component and Non-Component Based Programs

Fde Eds Tooh Wodspsce Window Mel

=17 System Admrestaton
1% Comcrate Strchue Sehup Her
5™ Stuctun et Mer
% (] D Martmarnce
= 1% Entiy Martenance
s
T Entey Modey
5 Erthy View
5] Shaeed St Waresnancs
w1 ) Protie Murierurnce
# () Geographical Sehue Meny
¥ Addess Sehp Haru
# (23 Engloyse Marterance
3 Dot Towrat Mrderarce
(3 tervescn Staus Conde Martenarnce
5 Withhaiding Tas Fiepat
55 Compenaton ba Thed Party eagon
2% 6L Nuamberng Regst
= (" Doman Comtaris Mans
iy Hebday Martanarce

W Tovren
15 L Accound Biomen fs Gl Taansactorn View Estarced
Ty Josmua E iy Crots Cy E el ndagration
) invcice Post and e
T Sales Doy Mamienance.
5 WHT T Castcat View

Entay Crome
W GoTo - | Actions <
Ahitachments

Tools =| # dmach

Ertty Code

Exntity Descipion
Busens: Falyen
Locakzstion Code

General [ Shared Sets | Addnonsl GL Numbering

Chack Burdgets om Ovedlas
Peverce PAL Alevakssions
Coruokdahon Eriky
Ditcenshs s Oty

trveat Uppes Lt

Mirex Satug.

Fle Eda Tool:

& Print

&

Taves

AP Erthard

Fuschaseg
2 Purchase Requation Menuy

1) Global Fnustion Mers

4| Bt Puschane Orders M

D lern Nettng Riesrachon

3 Suppler Schedules Menus
Fiy Puachass Ordet Mantanance
[ Puchase Orde Bromen

% () Puchase Oided Riaperts Merus

& Puchase Oide Bint

1% Puchasng Fieoepts/Fetun Menu

Allother programs dre
non-component based

5 Purchaia Order Recects

& PO ieceipt Packing Siotrauny
A Purchace Recect Raper

] Pachiase D ot |

4 Puschase flehun Documest Fint
i Unwouchesed Blsceipis a1 o Dot
i PO Containes Marionance

) FO Shppe Mantenance

(g PO Shippen Coritsret Iy
= PO Fiscal lsceiving

3 PO Fical Reced nqary

=5 PO Shopm Rrcect

=5 PO Shioper Deletntiachivs

Workgpace  Window  Helo

Component and Non-Component Based Programs

Enterprise Financials and System
Administration programs only

~ | Purchase Deder Ratums %

W GeTa o Acwens =] Conr = | & Print
Puchae Order bomt

5 Provew | @ dnach

Puchace Didec | fromt
ATV MR
Shprfrom
SterTo

Sasur

Only Enterprise Edition Financials and some System Administration programs are component-
based. All other applications are non-component based, including Standard Edition Financials.
Component-based programs have individual maintenance programs, such as Create, M odify, and

Delete.
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Navigating Component-Based Screens

Navigating Component-Based Screens

J Journal Entry Create
¥ GoTo ~ Actions = 7 Tools '| & attach | D Print x Preview
Attachments [l
Year |2omd|[ o5 | Posting Date | 05/05/2010_ ~ |
Daybook Code I s | & | WUUUWDN Layer Ty [ J Save As Template
Deescription | | Template Code i & i Feplacement
Dn?mal Fosting I Bl sequence Number | 000000000 1 o
© Relerence L | WY oo i
GL Account 4 GLDescripiion 4 Sub-Account C ¢ CostCe & Description ¢ Trans # TC Debit 3 TC Credit 4 Intercompany Code
»
el I | b
Curency View |Trarsaction Curency = | Tatal TC | 0.00|| 0,00
[ sweanocreste || swe || close

Because the component-based Ul is based on Microsoft .NET technology, it incorporates familiar
mouse, click and drag, and tabbing functions.
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Navigating Non-Component Based Screens

Ukchsirasss 63

Dudies st E/21/2007
Regued Date. 6/22/2007
Promize Date
Diuse Disbe: /222007
nnnnn Date
Piicing Diate: £/21/2007
Erechase Clickes

SeldTer CE4DOO

Line Pracing
Manuat
Diaybook Set. 5LS
Chanret

Dighaw:

ShipTe CE4DDD

2678

[
Cumency. EUR
Tanable H
Faoed Price
Crochl Tewns: 900
Sie: EMEADEG
00

B/21/2007
Langusge. us

Cirdd T

Navigating Non-Component Based Programs

RBar

Because non-component based screens are a rendering of the character Ul, you can navigate these
screens using the same keyboard commands. You can also use mouse clicks to select fields and

enter data.

If the program opensin .NET Ul mode, a navigation bar is displayed along the top of the screen
indicating where you are as you proceed through the program screens. For exampl e, the screen for
Purchase Order Maintenance includes a havigation bar indicating the parts of a purchase order:
Header, Tax Info, Lines, and Trailer.

Screen Navigation —»

Sales Dider
Hesder Lives Tes
> Heads
Header

Ordec| |

ShpTa

The Screen Navigation Bar option in the Desktop section of the Options menu (choose Tools|
Options) specifies whether your QAD .NET UI client displays the navigation tool.
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Navigating Browses

Navigating Browses

Sales Order Maintenance %
= GoTo ~ Actions »| L1l Copy =| =0 Print (& Preview | & attach
Sales Order: (> Order
Header Lines
B Header B Doinl B Infa = Fre > Sal B Delivery B Consignment B
Header
Order: Sold-To: Bill Tex Ship-To:
f—
.-;,‘18:!99 Order Master
Sold-To - = ”
x Actions = U= Print
earch
| Sales Order w | | starts at - )—7I_¢:] = )
Records per page: | 1010 - () @
Salez Order A% SoldTe % OrderDate © % Purchasze Drder
Iy 10005 CE4000 0B/21,/2007
tyaiails 10008 CE4000 0B/21/2007
reter Dt 10003 CE4000 08421 /2007
: 10012 CE3000 08/21/2007
Fiequired Date:
. o 10013 3000 0B/21/2007
oL 10016 CE3000 06/21/2007
Cive Diste: 10018 CE4000 06/21/2007
Ferform D ate: 10015 CE 2000 R/2242007

Many fields display a small magnifying glassicon. Thisindicates that alookup is associated with
thefield. Click theicon or use the Alt+L keyboard shortcut to display the lookup. The lookup lists
valid valuesfor the field.

A drop-down list is displayed when only afew values apply to afield.
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Navigating Process Maps

Navigating Process Maps

Bills, Routings
& Lines

Processes, or process maps, are graphical models of workflows that link to programs, browses, and
other process maps using advanced features of .NET technology.

Process map nodes provide drill-down navigation to individual programs within process flows.
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Drill-Down and Breadcrumbs

Drill-Down and Breadcrumbs

| Supply Chain View |
B3 S
Supply Chain Process Model » Accounts and Controls » Set Up General Ledger * Build Chart of Accounts

Build Chart of Accounts

Sul;lgéag?sol Management
E £ Posit annr-‘m:uaarnam = e
‘ormat Position eets an ‘ormat Position
Reports et — AL L et pos
v Statements ,_.._\-_./
et wik Define Accounts || Account Report
Sub-Account Enter
Browse I Sub-Accounts

Cost Center Enter Cost
Browse Centers
R

Processes are built with two basic components:
» Nodes are represented by various shapes and typically indicate a step within the process.

» Connectors are lines with arrows that indicate the direction of execution for the steps (nodes)
within the process.

You navigate the process map using nodes, and can re-trace your steps using the hyperlinked
breadcrumbs at the top of the screen.
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Summary

Summary
« You can display some non-component
based programs in terminal or .NET Ul mode

- Component-based programs display in .NET
Ul mode only

« A screen navigation bar is available for
some programs

Process maps let you drill-down on process
flows
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Exercise and Knowledge Check

1 The Screen Navigation Bar for non-component based programsis enabled in which menu
option?

2 How do you navigate between domains?
3 Which isthe only component-based application in QAD Enterprise Applications?
4 How do you display the program linked to a process map node?

5 Open up aSaesOrder Menu screen by navigating through the folders. Which three folders did
you open to get to the Sales Order Maintenance screen?

6 Open up Purchase Order Maintenance Screen using the menu search.

7 Open up Sales Order Browse by entering sobr009 . p in the menu search field. What is the
screen number?

8 Open up Sales Order Maintenance in terminal mode.

9 Display thelookup browsefor thefirst field of Purchase Order Maintenance. What is the name
of the master file used or name of the browse?
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MQAD
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Objective

Objective

+ Intfroduce the student to the extensive help
copob|l|’r|es of the QAD .NET Ul.
- Character Ul Help
- QAD .NET Ul Help
- QAD Assist
- QAD Guide Me
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Benefits

Benefits

« You willbe aware of the different types of
help and how it can be accessed.
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Training Flow

Training Flow

INnfroduction
Navigation

- Application Help

« Program Types
Browses

- Character Version
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Help in Terminal Mode

Help in Terminal Mode

Purchaie Quder Maintenance % ‘

| Purchase Order: Supplier: Ship-To: [

Purchase Order Masntenance X
Suplier —— gy [ Fio1d Felp : Purchase Order S

Pur Enter a number identifying an order or leave blank for
system-generated number. If blank, the system creates

Purchase Order iEl

h e number based on the purchase order prefix and next pur
Fuzchama Ordes order number maintained in Purchasing Control.
23 The sy=tem displays a warning if:
Order Date: 20010601
Dus Date: ki 1 o You enter a purchase order that has already been p
BI?;Y:I- acmioo 1f you modify the order, it may no longer correspos
- o asc the one sent to the supplier. You can update the r
Sales/Jok: fin (o] number to track additional changes.
Contract:
Sontact: o The order you specify was created in Scheduled Ord
Remarks:

Maintenance. Since different data is maintained fo
scheduled orders, you should normally maintain thes
their own program.

Enter data or press F4 to end.

Enter data or press F4 to end.

Help

» Thefirst time you press F2, alookup browse displaysif one is attached. If not, field help
displaysfirst. Use lookup browses to view records available to specified fields. You can
choose arecord to enter in the field. If you enter avalue and press Enter, the list in the bottom
of the browse frame scrollsto the first record that matches that value. Use the arrow keysto
scroll through the list, then select the record by pressing Enter.

» Press F2 again to display field help. It describes a specific field and how it isused in the
program. Most updateable fields have field help. Display-only fields do not.

» Press F2 again to display procedure help. It describes the program and how it is used in the
module. Procedure help is not generally provided for reports, inquiries, browses, or control
programs.
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Help Menu

Help Menu

File Edit Tools ‘Workspace ‘Window Help —<+—
¥ Applications |« @ search

AN X @ Application Help L+ Copyir ) Print
G711 Sales Order Maintena.... _Ill @ View Configuration F ® o
=711 Sales Order Repricing | = || _— .
[=ARK Sales Order Cost Rev... @ About

9713 Sales Order Credit Mai.. > Header > > Ta S

(37114 Sales Order Credit Ing... Header

ERARL] Sales Order Credit Re... - .

E7118 Sales Order Auto Cred.. v Order: | & SeldTo:

Sold-To

Select your favorite application
from the Applications menu and

drag it into this window to save
it

Help

» Search. The Assistance Panel is available by selecting Search.

» Application Help. Thisoption is available when your cursor is placed within a non-component
based field or screen. When you then select Application Help, field or procedure helpis
displayed for the field or screen.

» View Configuration. Opens awindow that displays various configuration settings that cannot
be directly changed by a user of the QAD .NET UI. These settings must be changed by a
system administrator.

= About. Display information about the version of QAD .NET Ul that is running, the time the

QAD .NET Ul was started, and the total amount of physical memory the QAD .NET Ul is
using.
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Non-Component Program and Field Help

Non-Component Based Program and Field Help

® ety BEE
QEORSS D

Sales Order Maintenance

Use Sales Order Maintenance to record items sold to an established customer and
define related sales information. The order includes due dates and pricing
information, as well as freight charges and taxes, if applicable. Sales orders control
and monitor the progress and cost of sales activities for both standard and
configured products.

NAVIGATION

Multiple frames display when you enter a sales order. The header frames include the
generic order information and set up defaults for line items. After completing the
header information, you can enter specific line items in the Sales Order Line frame.
Each line item lists the item number, quantity ordered, unit of measure, and pricing
infarmation. Rest list nrica. discnunt nercentans. and net nrice ara detarminad hy the ¥

Sales Order Available Fields ~

-~

Enter a number identifying an order or leave blank for a system-generated number.
If blank, the system creates a number based on the sales order prefix and next
sales order number maintained in Sales Order Control.

Tha mimbar mianahs idankifine = cnacifie ardar ar nandina imncaiers snd ke lims Famse

>

Press F1 or select menu bar help and program help will appear on the top of the page and field help

on the bottom.
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Component Based Help

Component-Based Program Help

Journal Entry Create ®

® GoTo ~ Acti -
—————————1]|T0C = > Index
Attachments
General Ledger Transactions
Year ﬁ )~ s
= Journal Entry o— il
DaybookCode [ mpumnat e, crome s e bsicanocion o o xcuring st 1 | Save As Template
[ mest 2 joumal entry is P muitipis |
1 pOoSING ines, each of nem associabed with 3 GL account and an amount lace:
Descrlptmn Heverthebess, in most Cases. Joumal enies 3150 Nave OMer SMensions. = Repl ment
Original Pesting [ Tepresented by anatical eooes ~ 000000000
000000000 | R
Reference Use the Joumal Entry acities (2513 1)t create. waw, modiy, delete, and reverse Bt
Joumal enfries. You can 1.1} cnly to manually record
fransacons for Snancial iy View (28.13.1.3) s you
GL Account O RO TC Debit L] TC Credit (]
» s e —
Nate: You can anly modity o delite journal enties postedto a bansient layer See
Toanaiac! Lare

When you select help within a component-based screen, the system displays a context-sensitive
help topic for that screen within the QAD Assistance Panel.
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QAD Guide Me

QAD Guide Me

Sales Order Maintenance X L

® GoTo * Actions * | Copy * (= Print '« Preview # Atach

Customer () Order
Header Lines
P Header B omis B > (S >
Header
Order: A|  Sod-To Bill To

Enter a number identifying an order or leave blank for a

Sold system-generated number. If blank, the system creates a Ship-To
number based on the sales order prefix and next sales
order number maintained in Sales Order Control. More...

Edit

The QAD Guide Me feature provides immediate mouse-over descriptions of fields in both
component and non-component programs. The feature is disabled by default.

Note Field help for non-component based programsis also displayed by pressing the F1 key
when the cursor is positioned in the field. Click the More... link to display an extended description
of thefield, and the Edit link to edit this description in Field Help Maintenance.

Note The Edit option isonly visible for users who have access to Field Help Maintenance.
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QAD Assist Panel

QAD Assist Panel

QORI

> Index

Table of Contents

Introduction to QAD Financials
Overview
User Interface Features
Business Model
Domains
Entities
Shared Sets
Profiles
Business Relations
Multiple Currencies
General Ledger
Supplementary Analysis Fields
Intercompany
Daybooks and Accounting Lavers
Other GL Features
General Ledger Transactions
GL Consolidation
COoA Cross Reference
Accounts Receivable

QAD Assist Panel

The QAD Assistance Panel provides online Help for the .NET Ul and for Enterprise Edition
applications. Assistance replaces the previous .NET Ul and application online help files, and isa
searchable HTML interface that is displayed by pressing the F1 key. The panel can also be
accessed by selecting the option in the Help menu. The Panel features links to program help, field
help, user guides, and process maps. You can display results for the search entry in any of these

formats or in all of them.
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QAD Assist

QAD Assist

Program Help | Field Help | User Guide | Process Map | an

[work orders

Work Orders

The Work Orders module enables you to manage manufacturing orders in discrete
manufacturing environments.

Work Orders

Work Orders Programs Affected by WLT shows the Work Orders programs affected
by enabling the WIP Lot Trace module.

Work Orders

Work Orders
See User Guide: QAD Manufacturing .

Work Orders

See .

Work Orders
See .

Single Terms and Phrases

You can search for singleterms (such as‘ Test’), phrases (such as ‘Work Orders') or complex terms
using operators (such as ‘test AND system’). The panel stores default fields, which you define dur-
ing deployment, which do not need to be specified when searching. The following operators are
supported by the panel:

AND, +, OR, NOT, -
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Summary

Chapter Summary

Program and field help is available for both
component- and non-component based
applications.
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Exercise and Knowledge Check

1 Launch Purchase Order Maintenance in terminal mode.

Press F1 in thefirst field of the purchase order.? What is displayed? Press F1 again. What is
displayed thistime?

2 Gotothe Sales Order Maintenance screen and select Help|Search. What screen is displayed?
3 Do asearch ontheword Sales. Drill down on Sales analysis. What is displayed?

4 Goto Journal Entry Create and hit F1. What is displayed? Note the differences between a non-
component based help and component based help.
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Objective

Chapter Objectives

« The objective of this chapter is to describe
program types and program features in
QAD Enterprise Applications.
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Benefits

Benefits

« You willbe able to identify different program
types and will be familiar with some basic
Enterprise Applications program features.
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Training Flow

Training Flow

 Introduction

+ Navigation

« Application Help
- Program Types

« Browses

- Character Version
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Program Types

Program Types

« Maintenance Programs
Inquiry and Report programs
Browse Programs
« Transaction Programs
Utility Programs and Control programs
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Maintenance Programs

Maintenance Programs: Component- and Non-Component based

ltem Master Maintenance ><| I
@ GoTo ~ - Actions = | Copy ~| & Print ~ Preview & Atach I
Product Line: (1)
GL Account Create ¢
ltem Planning Price : | o
> item B R @ GoTo - i Actiong T 4 Innls ‘j ﬁ Aftach J ..:.,J Print & Preview
Altachments
ltem
Item Number: GL Account !l_ |
Unit of Measure: Dieseription ! 2|
GL Type ! Standard Account - ! st T ‘
ltem Data Active v Budget Group ! 4 | @
Prod Line BudgetEnabled W Category L%{{%_
Status:
Design Group: Posting | Currency ” Analysis "F!epor’t L\nk" Banking || 1sh "Defaults
Added:
LearlnanionData
| Balance Shest Aceoun! = | Debit/Credit  Debit |
Auto/Manual | Manual - |
Intercompany Account [ Diefault Intercompar | - |
Fived Intercompany

The Item Master Maintenance and GL Account Create Entry are examples of maintenance
programs that update the database directly when the record is entered and saved.

In the case of non-component maintenance programs changes to the record will be made in the
same maintenance screen, where as in component based maintenance programs changes are made
in the Create, Modify, or Delete maintenance screens.
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||Iem kaster Inguiry - 5/2452010.. * |

N

Item Master Inquiry

QAD

Site Description
Ttem Number: 010

|Item Cost Report |Item Cost Report - /2472010 1. %

05f24/|

Inquiry and Report Programs

Line Description

Site: 10-10-100

UTtrasound Mfg Site

10 Finished Goods

7 01010 EA Medical Ultrasound
Prod Line: 1C
. Added: 01 Cost Set Material Labor Burden Overhead
Design Group: PR
Promo Group: ME
Current 225.71 19.34 0.28333 0.00
13,/01/10
ABC Clas Standard 225.71 19.34 0.28333 0.00
Lot/Serial Controys o110
59t
Locatic 01011 EA Supplies Kit
Location Ty
Auto Lot Number Cost Set Material Labor Burden Owverhead
Lot Grou
Article Numbe
Current .00 0.00 .00 0.00
13,/01/10
Corp Comm ot Standard .00 0.00 .00 0.00
Ship Weigh3m1/10
Freight Clas
01020 EA Implantable Ultrasound
Cost Set Material Labor Burden Owverhead
Current 144.815186 25.09176 0.36372 2.00
13,401,410
Standard 144.815186 25.09176 0.36372 2.00
13,401,410

Inquiries and reports retrieve and display operational database records. Inquiries are primarily
used to answer specific questions. Reports usually provide more detail and are printed for arange
of datarecords. You select data by entering a specific range of criteria, such asitem number or

date.

Typically, inquiries are viewed online and reports are sent to a printer or file. However, you can

also print inquiries and view reports. In addition, other output options, such as e-mail, are

available.
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Component-Based Report

Component-Based Report

GL Account List X

< Tools | &b Print » Preview  Variant =

Report Variants FACTORYDEFALLT -
Fiter

GL Account .5 %

0 . n GL Account List

= ~  QAD
GL COA Element TySys Type DebitiCredt  Balance/PEL  Auto/Manual  Analysis Type
Account
05000 STAMNDARD DEBIT BALANCE MANLUAL Maone
05600 STAMDARD DEBIT BALANCE MANUIAL Maone
03610 SYSTEM RESULTCURRENTYEAR CREDIT BALANCE AUTOMATIC Maone
05620 SYSTEM RESULTPREVICUSYEAR CREDIT BALANCE AUTOMATIC Mane
09000 STAMDARD CREDIT BALANCE MARLAL Maone
09100 STAMDARD CREDIT BALANCE MARLAL Mone
10000 DEBTORCOMTROL DEEIT BALANCE AUTOMATIC Maone
10100 DEBTORDOCUMER DEBIT BALANCE AUTOMATIC Maone
10200 OPENMITEM DEBIT BALANCE MANLAL Maone

Server Output Processing 10300 DEBTORCONTROL DEBIT BALANCE AUTOMATIC Maone

10600 DEBTORDOCUMER DEBIT BALANCE AUTOMATIC Maone
11300 STAMDARD DEBIT BALANCE MAAMUAL Maone
12200 BAMNK DEBIT BALANCE MARNUAL Maone
12201 BANK DEBIT BALANCE MARLIAL Maone
13000 STANDARD DEBIT BALANCE MAANLIAL Maone

Component-based reports have multiple output options, including viewer, printer, and export to
PDF, XLS, and DOC standards. The report output is easy to customize, and you can create an
extensive set of reports with unlimited report variants for many output types.

You can run areport immediately, or choose to schedule it to run later. In this case, a pop-up
window opensto let you enter details for running the report at alater date.
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Transaction Programs

Transaction Programs

Purchase Order Returns * I
% GoTo ™ Actions ™| Ll| Copy 7| IE) Print s Preview § Attach |

Ordercall07 —‘
Journal Entry Create %

- i -4 - ]
Prichisss O can{)?_fugPTo Actions ¥ 74 Tools ! & ittach ! @,,J Print %] Preview

= Attachments
RTV Nbr:| 1234
Year amof 05| Posting Date 05/24/2010 ~ |
Ship-From:| MOT0C b qubiok Code |JE e ‘ 00000000 | Layer Type [ OFFICIAL ] Save As Template
Ship-Tor| at100  peseription | Joumal Ertry ‘ Template Code -~ Replacement
Original Posting | cequence Nurber | 000000000 71 -ve-o)
el 2| Sequence Mumber ¢
GL Account 4 Sub-AccountC ¢ CostCe ¢ D escription 4 Trans Curr 4 TC Debit L] TC Credit L}
1100 Expense uso 1.000.00 0.00

Expenze 0.0o0

Transactions programs control and record activities related to business documents such as sales
orders and invoices. An example of atransaction is receipt of a shipment for a purchase order
using Purchase Order Receipts or Returns. Enterprise Financial s transactions programs include
Customer and Supplier Invoice, and Journal Entry.

Most datain the database is transaction data. Every day, sales orders come in, purchase orders go
out, and work orders make demands on and create material for inventory. These events result in
transactions, which are stored in transaction tables. In contrast to control programs, transaction
tables are constantly updated by users of the system.
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Control Programs

Control Programs

\work Order Comments:

Routing Comments:

Move First Operation: ¥

Purchase Order Returns X
M GoTo ~ Actions = | .| Copy ~| '8.1 Print s Preview § Aftach
Order:call07 @ Purchase Orderca1107 _@) SH\i)-i:i'om:I:\;'lﬁ'l 00
Purchase Order: calll7 Sunnlier dr100 Statius Ffiective | 5247010 =1
ATV Nbr| 1234 Work Order Control X
H GoTo ~ Actions 7| .| Copy ¥ | (=) Print [a] Preview
Ship-From:| MD100 =
Ship-To: _.'dﬂ 00 Auto WO Numbers: ¥
" NectwO Nbr|  1022]

Control Data

When you implement amodule, you enter data that the system uses later to control how the system
interacts with users and with the database. This datais stored in control tables. Control tables
enable you to adapt the system to your environment. The data and settings in these tables
determine how certain programs are displayed, the numbers assigned to transactions, the GL
accounts for particular transactions, and so on. When you can manage a typica manufacturing

function in more than one way, control programs let you establish a preference.
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GoTo Function

GoTlo for Non-Component and Component- Based Programs

Sales Order Maintenance *

W GoTo v} Actions v | /| Copy ~| & Print (] Pr
PO Maint ~ Order

Add Link
> Header [ T P T o B >
Header

Order: _,'W‘

W GoTo:” fcfions 42 Tools *| @ sttach | (2 Print A Preview
Related Views »

L3

Create Mew Budget Group

@

Create New GL Account Unit of Measure

Ly | e
Active v Budget Group
Budget Enabled

The GoTo menu for non-component based programs such as Sales Order Maintenance displaysthe
Add Link option. Use Add Link to create links to other programs using User Tool Maintenance
(36.20.4). The links you add display on the Program Links drop-down

The GoTo option for component-based programs displays GoTo options and Related Views.
Related Views are commonly used views and reports that apply to the record you are currently
working with.
Go To behaves differently depending on whether the current field has dataiin it:

- If thefield has avaue, Go To invokes the View activity.

- |If thefield is blank, Go To invokes the Create activity.
All of therelated views take the record you are currently using as the base for the information.You

can simply click the GoTo to see the Create New Budget Group or Create New GL Account Unit
of Measure.
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Messaging

QAD Messaging

File Edt Tool: Workspace Window Help

| Mazeages —Inboe |

| sales oider man %] [
55 Sales Ordes Maintenance

Filleg one From

From Dete

— “ New | = Reply ©¥ ReplyAll =% Forward | ™% Move 3§ Delete <3 Frint | o Refresh | % Hide Details

Delouk MFG User  Z5/05/2010 103405 _ Sedes Oidr Maniznance (10001)
Defaul MFG User 25/06/2010 103226 S ales Drder Maintenance (01000000)
Dofaul MFG Uses 1291 Sal ;

G oo 102844 Purch

From: mig

Te: Defaul MFG User

¢ Sales Order Maintenance (10001)

102759 Pusch

Subject Safes Order Mantenance (10001)

- Please review and approve the following sales order:

The QAD .NET Ul includes a messaging capability so that you can send messages and workflow
information to other users of the system. When using programs, browses, inquiries, and process
maps, you have an Inbox on the Right side of the application areafor sending and receiving
messages. You can also send program or browse workflow messages, which include links to
programs or browses, by choosing Actions)Workflow when using a program or browse

To Send a Message

« Click the Compose Message icon.

message.

In the content area, enter or paste message content.

L]

MQAD

In the To field, enter the user IDs or names of the users to whom you want to send the

In the Subject field, enter text indicating the subject of the message.

Click Send to send the message (or click Cancel to cancel it).
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Workflow

MNor-Component

—_—

0 GoTo ~ Actions ‘:i  Copy ‘: 'E'..J Frint » Preview i §]
ales Orderds ) Mext (¥ OrderalT02
eadsr Line € Back [l Journal Entry Create - @'
Header Next Record| ® GoTo 7| =) Print (8] Preview
Previous Rer
Insert “workflow Mame Joumnal Entry Create b Load I [ Store I
il E workflow i :
e : Role EmployeeM atify -
Orde —  E-mail
Requiret Export Data Fequired Activity Review -
Promise D ate: Feturn to Sender x| &g =R
D Date: . QM1 User PM
Sales Order Maintenance (AUTOZ)
Irstractiens P Sales Order Maintenance (AUTO?2)
'S + _ % NewMessage =% Reply io% ReplyAll =% Forward 3 Delete
CMpPonenT ——— &
R From: | QM| Lser
Tar ami

Subject | Sales Order Mamienance [AUTOZ)

Sales Order Maintenance (AUTO2)

Workflow is available for both types of program and is visible as an Actions menu option for non-
component based programs and as a Tools menu option for component-based programs. When you
click Workflow in a non-component based program, the system creates an e-mail message for
another system user, with the current screen as an attached link. This e-mail is then posted to the

user’s Inbox.

In a component-based program, you use the Workflow object dialog to specify the name of the

workflow, the role of the recipient and activity they are required to perform on the link.
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Copy

Purchuse Drdet kartenarcs
- Jele* Agwyen * Capy ¥ 2 Pree 5 Prevew
Handed  Limas
" Hoodw » [ | 3 ™ » > L > »
Heade:
Puschaie Dulee 1000 Supcle:| IND So-le 0D
S Lel
Fage e
S Fis B Fomsst Viea Help
Frama: wsadar
Purchase Order: 1000
Supp! fer 310
Dwege L ERE ship-To: 12000
Frase:  Suppl la
Untwe Shaben Fage Inz,
10 matn Street
P chicago
. 00818
Ondet Dtwe L5008 Pacs Thi united states
et Dire LE00R Dise T Frana:  ship To
i Blam
By Lnbsc o 21 ventura Blvd,
[ 1 Siw Lot Angalés
<a
Cyeuihb Daybocd S AP 3210
A ited state
Certroat terane:  petalls
Order Date: o1/00,/2000
Cortak Price Tol:
conffirming: rue
Rersabx: iy nH-rt-a_ false

The Copy menu is only available for non-component based programs and lets you to copy the text
of the current screen to the clipboard, or copy an image of the current screen to the clipboard.
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Print

| Purchase Order Maintenance x|

® GoTo - ' Actions ~| Ll Copy ~| & Print 4| Preview | & Atach

Order114 () Purchase Order114

Header Lines Tialer

P Heads ™ Detalz B Taxinc P Logistics B Defvery B ERS B Consignment B Comments
Header

Purchase Drda.| 114 pel Suppler: 3009 CLi T uinans
Suppber
Acme Supply Co.
1 Clanidge Drive
Wesona MNJ 7044 Comment: ™ Printto file
Urited States
i~ Print range: Copies
Fide o~ Al Mumber of copies: i'\ a.
et
 Pages fiom [0 to: IIJ
Order Diate: 23/07/2003 Price Tbk - @ ﬁ R Ctate
Selectior
Due Date: 0/07/2009 Dise Tk ezl .
i i ok |
Cancel
Salesdlob: Daybook Set: defap Credit Terms: 2/40PROX 0.00
Contract: Froject Ertered By: kie
Contact Requested By,

The Print menu is common to both types of program and prints the current screen to the default

printer.
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Attach

Attach

Sales Order Maintenance
‘# GoTo ¥ Actions W | | Copy W | (&= Print : Preview | g Auaok
= sl S - | @ Sales Order:10004 (1)
Sales Order: 10004 [1 (v)  Order10004 |3
i M w & Order:10004
Header Lines 1
I Header » [ > nfa P Fieigh > ; B Debve > . [
Header
Order | 10004 A SoldTe CU2500 Bill To: CU2500 Ship-Ta: CUZ500
Sold-To Ship-To

Attach lets you attach any type of document—such as a Microsoft Word file, graphicsfile, or
PDF—to arecord within the application. This integration ensures that al required documentation
isimmediately accessible when needed. You can attach and view any type of fileif the

corresponding viewing software is available on the client. Thisis both applicable to component
and non-component based programs.
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Record Program Actions

Record Program Actions

Sales Order Maintenance

M GoTo ¥ Actions v| led]ivcd
Sales Order1000 @  MNext

Header Linez ) Back
> Header = Mext Record

Head =
Facet Previous Record !

Drder:{jﬁﬂﬁé =3 " Options ~

Inzer

E workilow Comment

SoldT
serte E-mail

e = Purchase Order Maintenance
Flosy's Bike Shop ¥ ExportData

Frame Target Field Comment
+ I
next po_nbr
po_nbr
po_vend
_ship
po_ord_date

submit
submit
submit
submit

oo oW oW oW

al il | [

The Program Export File function isatest utility in the QAD .NET Ul and isavailable in the
Actions menu for al non-component based programs. Thisfunction letsyou record your actions as
you complete an application process and save the recorded actionsto an XML or .XLSfile that
you store locally. You then execute the saved . XML or .XLSfile in the Execute Document Import
function to reproduce the recorded process on screen. Saved files can be exported for testing to
another QAD .NET Ul environment, or imported into the current environment.

1 Launch aprogram.

2 Choose Actiong|Export Data. An Export Data screen is displayed (minimized) on the screen
while the system is recording your user actions. Each user action isimmediately listed in the
Actions grid of this screen, and you can pause, name, and save the recording in this dialog

3 Enter avariety of actions for the program. These actions are now recorded. The Export Data
dialog lists the actions, frames, and fields being recorded.
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Saving and Browsing Drafts

Saving and Browsing Drafts

Actions =% Tools = # Aty

Undo Citrl+Z
= Save Ctrl+5 | SysterniUser setting x‘
&'y Save and Create 4 % Actions = 7 Tools 7 \;‘;') Print » Preview

Save As Draft N -

Active Setting
- eals * » [] Diraft Instances
1 View Ctrl+B 1 Business Logic Version Checking
& Modify Cri+0 | Field Security
: G ;
X Delete Ciri+D v Automal!c Save of Grid Settings .
v Automatic Save of Last Used Browse Settings

Transient Create v Allow Save of Grid Settings

Transient Modify vl UserDefined Fields

Hiverse v Ewent Publishing

Intert. tomizati
Riswisroma doirial Gesats v User Interface Customization
: v ‘wiorkflow

Transient Reverse ] Enable Persistent Cache.
E Browse Drafts -]

Properties...

Exit Alt+F4

The Save as Draft and Browse Drafts options are available for component-based programs only
and must be enabled in Change System Settings. When Save as Draft is enabled, you can save
selected records without completing al the validations required to ensure that the record is
complete. You can then finish adding datato the record at alater time by using the Browse Drafts
option to find the incompl ete record. Only the following subset of components provides the ability
to save unfinished records as drafts to be completed and approved later.

« Banking Entry
 Business Relation
« Petty Cash

« Customer
 Customer Invoice
 Finance Charge
« Journal Entry

= Supplier Invoice
» Supplier
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Summary

Chapter Summary

In this section you learned about program
types and menu features for both
component and non-component programs.
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Exercise and Knowledge Check

1

2

Sales Order Control is an example of what type of program?

In Sales Order Maintenance, select the GoTo function. Add alink to the Sales Order Browse
program sobr009 . p.

Open up asales order and GoTo the Sales Order Browse.

Display a completed sales order in Sales Order maintenance and send the sales order to your
User ID by using the workflow.

Create adocument in MS Word. Save it to the c:\ drive and attach the document to a purchase
order.

Select GL Account List, run the report, and send the output to a printer.
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Objective

Chapter Objectives

« The objective of this chapter is to infroduce
browses in the QAD .NET Ul.
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Benefits

Chapter Benefits

« You willbe familiar with the different types of
browses in the QAD .NET Ul.
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Training Flow

Training Flow

INnfroduction
Navigation

« Application Help

« Program Types
Browses

- Character Version
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Introduction to Browses in the QAD .NET Ul

Infroduction

+ Browse Topics

- Look-up Browse

- Power Browses

- Filters and Operators

- Component-based browses

- Favorites

- Grouping

- Column Options

- Managing Filter Fields

- Browse reports

- Quick Search

- Operational Metrics

- Excellntegration and Browse Excel output
- Using the Chart Designher
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Lookup Browse

Lookup Browse

f
8 F Customer Master

wal-Mart

Bentorwile

polTo: Astions 7 = Print
| Search -
iCustomar o | |starls at - | | ,(O[ .v] |
Records per page: Wl G:) @ @
Customer A % Sort Name £ W Telephone 2 7 City £ W State

10C100 MediLogic Bridgewater MJ

10C1002 Houszton Automotive Grop Houston TA

10C1002E8 Houston Automotive Grop Houston TH

10C1003 Pacific Health Care Systems Los Angeles C

Line Pricing: 10C1004 Price Chopper Schenectady MY

Marual 10C1005 Fockland Industrial Comparny Fiockland M

TOINTCUS G - USA Division E ast Hanower 4]

Daybook Set 1C1000 Ciyacath Technolagies Inc. Kirkland ac

Efiannel 11C100 Chit Fonds fimited Edmonton BB
Project: 11Cio0z2 General Mators of Canada Ozhawa

Return the value selected to the active field in a calling program. The lookup browse has limited
functionality. Look-up browses cannot filter, graph, or print data

In the example, when you select the lookup Sold-To in Sales Order maintenance, you launch a
lookup browse of Customer master.
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cliong

[sai-Ta

Yiewing 1-15 of 15

Power Browse

Sales Order Browse *

% Actiong ~ \?.a Print

Records per page: | 100

10003 cul1500
10003 cul500
10010 CU1500
10011 CU1500
1002 CU1s00
1002 CU1500
10004 Cu2500
10005 CUZ500
test10 Cuzs00

@ Chart Designer | € Refrech = | Mew # Edit

Ple) - + x Search Clear All

1 P0e® @

Saw 4 W SoldTo £ ¥ QuantiyDpen & ¥ Line & 7 ltemMumber A 7 Status & 7 Unitof Measwe &7 Quantity Oidered & 7 [

1 10-10000-001 FT 100
2 10-10000-001 FT 100

11NN T 20

|Sa|es Order Maintenance | Sales Order Browse ?i|

Aotions ™ 'gl Print © - Addto Favarites | g ©h %ﬁ Chart Designer | ca
E Exportto G5V
E Exportto Excel !_starls at - }-’@ - | |
- Exportto FDF Flecords per page: [ 100 - |q‘J (
= workflow
o ad-To & W Status & 7 Line & 7 ltemNumber & Unito
| E-mai -
C1001 1 02200 EA
Ej Feport
B __C1oo0 1 02200 Ea
TRANS1 30C1002 1 02200 E&
TRANSZ 20C1000 1 02200 EA

A power browse can filter, sort, print, and graph data. Any column can be sorted. The first ten
columns can be filtered.

Navigation

» Use the navigation buttonsin the top left (1) to move through the records. The buttons from
left to right move to the first set, previous set, next set, last set.

» Use the Records per page drop-down to determine how many records display at onetimein
the browse. The default value can be set using the Rows Per Page setting in Tool s|Options.

» The Max Browse Recordsfield in User Options Maintenance does not apply to browsesin the
QAD .NET Ul. Use Toolg|Optionsin the .NET UlI.

- Attempting to display alarge number of records at once can adversely affect performance.

Instead, use the Search conditions to focus on the specific records you want to review.

« Drag columns by their headings to rearrange the display.
» Asashortcut, instead of clicking Edit, you can double-click on the row that includes the item.

Sorting

« Click Clear All to clear browse results.

« Any column in the title bar can be sorted.

« Click the heading to sort ascending order; click again to sort in descending order.
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« Columns that cannot be sorted are generally non-indexed fields. Sorting by such fields
degrades system performance.

« Blue underlined text indicates values for which you can drill-down.

+ Use Browse Maintenance to set the default sort order for the multiple sort orders for the
multiple columnsin a browse

« Right-click any value to display associated links: either a more detailed browse, arelated
program, or an external Web page.

Actions

By selecting the Action menu (2), you can export the browse to .CSV, Excel , PDF or areport. In
addition you can email the browse or include it in a workflow.
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Filters and Operators

Filters and Operators

Sales Order Browse |

Actions * '.‘:'., Print * ; Addto Favorites | |y t @ Chart Designer | € Refresh * | News f Edit
Search
_Eustnmgr\tem ’_.“ —
Description — Records per page: 100 - DEORORC 9
-Du;(%te —
5| Expifes ¥ Quantity Open & W _Line & 7 _ltern Nurber 4 ¥ _Status & ¥ Unit of Measure & 7 Quantity Ordered 3

Sales Order Browse

Actions © d;ﬁJ Print ° ; Add to Favorites Wi att i@ Chart Designer € Refresh ' | Mew /’ Edit
1 Search
[SeldTo - |[satsat [ Pel- ]+ x
— equals — = — /‘
Wiewing 1-15 of 15 not equals 5 per page: |100 M| 4) (1) Q),- ») ®)
contains = = TF
Sales Order =W Sold{rgnge en < W Line &% ltemMumber A 7 Status & W Unitof Measure & % Quantity Ordered
arts at /
10003 cul8] greater than 0.0 1 10410000-001 FT
10009 15 ::;Su‘”ha” 400 2 100000001 3 FT
10010 CU1E s not rmull 2.0 1 1010000001 FT

Filtering. If stored search criteria exist, you can select one by name from the drop-down list at
the top of the search criteria (1). This sets up the filter criteria (2) to produce preconfigured
results. Otherwise, the search fields display with adefault configuration. Refine the search
using combinations of filtersand wild cards (*, and ‘.’ for Financials browses). Click the + and
X buttons (3) to add and remove search filters.Click Clear All to clear the browse results.

1

Search Operators. The various operators includes equals, not equals, contains, range, starts at,
greater then, lessthan, isnull, and is not null. When an equal sign is displayed next to thefield,

you enter an exact matching value.

To refine your search further, click the plus (+) icon to add another search row. You can add as
many rows as needed, each with different search values and operators. If you choose the range

search operator, the second search box is enabled for the ending value of the range.
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Component-Based Browse

Component-Based Browse

‘Supplier Invoice Browse for Ma_. x|
I L

Actions ~ l."‘-,;' Print ' Add to Favorites | (g l§ Chant Designer | @ Refrash ~ ﬁ Stored Searches =
Search10)
[Supple: Code v | [oquets - P2 - + x search | [ Clearan |
[Business Relation = | [equals - I3 - PR
|Reeterence ~ | [equals - [2] - * %
:Yau | | equals - E ' + x
[Daytook Code ~ | equat - Pla] - +* x
[Woucher > .equals - ,DE - | + X
T I =) I
Viewing 1-7 of 7 Records per page: [ 100 T P@Qe® | @
Suppler &7 BusinessRelsionCods & 7 InvDate o'W Reference &7 TCBalance & % Cur £ W DusDate & W Description >
EUROOT 11/02/2010 Fr Supphes 1273172010 Fr Supphes AFELURODT
A2004 Subconbactors Inc. 11/02/2010 SubCont 3455300 USD 0173172011 SubCont A2004
42001 Carbon Frames 11/02/2010 CasbFrame 3340000 USD 01/3172011 CarbFrame 42001
A2002 Tube City 11/02/2010 Tubes 78,990.00 USD 0173172011 Tubes AZ002
42003 100% Pure - US 11/02/2010 Aginv_US 40,.980.00 USD 0173172011 Apiny_US A2003
A2003 100% Pure - US 11022010 Aglr_US -2,000,00 USD 0173172011 Aplny_UIS A2003
A2005 Cotazon 11/02/2010 COR -3,000.00 MXN 01/3172011 COR A2005
Summalies:
Sum =-194,123.00

Component-Based Browses

Component-based browses are launched when you view, modify, or delete arecord created with a
component-based activity. For example, Supplier Invoice View (28.1.1.3), Supplier Invoice
Modify (28.1.1.2), and Supplier Invoice Delete (28.1.1.9) all launch browses, in which you select
the record on which you want to perform the activity.
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Browses as Favorites

Sales Order Browse X |

Actions T.E,',.J Print *©  Add to Favorites I iy Chart @ Chart Dezigner I @ Re
Search 2] A . o —
ESDH'TD 'T |equa|s -| ‘ cul500 /'-)I -"I b |
| Quantity Open v |oeater than = ! i D[LI =)

“iewing 1-5 of 5

Records per page: |1hﬁ

1@ @

Sales Order 4+ W SoldTo &% Ouantity Open & 7 Line & 7 ltem Mumber ~ 7 §
L3 10010 CUA500 1 10-10000-001
10011 CU1500 20 1 10-10000-007
0mz CUA500 3.0 1 10-10000-001
10009 cul500 10.0 1 10-10000-001
i0mz U500 20 2 20-10000-001
I

Saving to Favorites

Click the Add to Favorites button. The browse is saved to your Favorites area and named based on
the name of the browse. If it isthe first instance you have saved, the browse namein the Favorites
areaisthe name of the browse. If you save the same browse again, a (2) is appended to the namein
the Favorites area. Once you have saved the browse to the Favorites pane, you can rename the

browse and organize it in the same way as other items saved in the Favorites pane.
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Re-Naming Favorites

Re-Naming Browse Favorites

4 Sales Order Browse *

Actions T @ Frint ° © Add to Favorites

| Mamu Search ‘
B[ Sales Order Meru [«]
Ellﬁ Customer Schedules Setup Menu

Search [2]

15 Schedule Processing Menu
[#7) Containerization Menu
@u’j Shipment Processing kMenu

sile  Edit Tools ‘wWorkspace

window

CLI1500 Browse]

[#47 Sales Order Reports Menu

I'flia Legal Documents kMenu l‘g Rename Menu Search |
BT Sales Duotation Menu |8 Change Iron | EE) Sales Order Menu B
FHET Irvoics Menu @ Remove [#H{ 7] Customer Schedules Setup Menu £
- 7 Sales Order Feports Menu [ i |E|
BHE P Auto Start lﬂ@ Schec.lule.Pro.cessmg Menu El
#{7) Containerization Menu
2 0lopse fflenus #=) Shipment Processing Menu
Open [#7) Legal Documents Menu
Design FHET Sales Quotation Menu
[#7) Invoice Menu
Properties

Re-Naming a Browse

1 Right-click the browse.
2 Click on Rename.

3  Rename the browse.
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Grouping Results

Viewing 1-100 of 303

+ Description: 1000 (1 itern)
= Description: 1001 no sub-acct (1 item)
= GL Account:1001 (1 item]

+ Sys Type: (1 item)
+ Description: 1044 Draft Accepted (1 item)
+ Description:1044 Draft Allocated (1 item)
+ Description:1044 Draft For Collectio (1 item)
+ Description:Accounts Payable [1 item]
+ Description:Accounts Payable DM (1 item)
+ Description:Accounts Payable SPP (1 item)
+ Description:Accounts Payables Acct (1 item)
+ Description:Accounts Receivable (2 items)
+ Description:Accounts Receivable Acct [1 item)
+ Description:Accounts Receivable ELIR [1 item)

Records per page: B oo - ‘

Right-click and select Group to group data by column type. The grid displays a summary of the
column data, with the different elements sorted into groups. Each group in the list can be expanded

using the plus sign next to the group.

Add other columns to the grid to create a group hierarchy. Group options are saved automatically
in your last used settings, and can be reused when you open this browse again. You can also save

these options as a stored search.

To remove the split, select the bar icon in the second panel and drag it back to its original position.
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Summarizing Results

Summarizing Results

Role Mame &%  BCBalance ¢ W Type & W Subdcct &7 SCBalance & W

20000 Imvoice 10 200,00

21000 Inveice 10 210,00

-100.00 rvoice 10 -100.00

20000 brvoice 10 200,00

A2500 Irvoiee 10 -125.00

-4935.00 Irmvoice 10 -4.935.00

600.00 Irvoice 10 500,00

<100.00 Irvvice 0 -100.00

22000 Irvoice 10 -220.00

-400.00 Irvoice 10 -400.00

-100.00 Invoice 10 ~100.00

10000 koveice 10 -100.00

-200.00 Irvoice 10 -200.00

1000 frvoice 10 110,00

500.00 Irvoiee 10 500,00

~1.000.00 Irvoice 10 +1.000.00
Sum =-3,260.00
Count = 17
Average = 544 71
Mirwenum = -4,555.00
Mazimum = <100.00

The Summary right-click option lets you display summary information, depending on the column
header in which you have clicked.

You must be able to view al the records on the screen page to enable the Summary option. If there
are more records than can be displayed, set the Records per Page field to All.

By right-clicking the BC Amount column in the results grid for Supplier Invoice Browse, you can
display the following summary information:

Sum. Displays atotal sum of the invoice amounts
Count. Displays the number of invoice records
Average. Displays the average of the invoice amounts.
Minimum. Displays the lowest invoice amount.
Maximum. Displays the maximum invoice amount.

Note You only see meaningful resultsif the operator you choose applies to the data type. For
example, applying the average operator to a date column does not produce a meaningful result.

Minimum and maximum are useful with dates, and summary and average with numeric fields.
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Column Options

Column Options

Sales Order Browse *

Actiong 7 é_'}) Print * ;' Add to Favorites I ille Chart @ Chart Dezigner I € Refresh 'I :| Mewe i’ Edit
Search
|Salas Order - ‘ |slalls at - | | j-)! .r] - | | + X
Wiewing 1-17 of 17 Records per page: !100 - ;) @) @ ) ‘:‘
2 —Sates¥Erder “ W SoldTo ¢ 7 Status &7 L inp w57 |tem Nurbe < % Lnit of Measure @& % Quantity Ordered & 7
Autosize Colurnns
_— 3
10019 CE4000 4 A 3 10.0
plasas s e T I — 100
Actions ™ (=0 Print v Add to Favorites Graoup By Line 100
] o Show Group By Box .
Seatch 1| e ing 10.0
S [ — ] I
Vi*g 1-17 of 17 Reed | summary , 20
tear all Flters 20
Tt of Measu & 7 Unitof Measu & 7 100
E% Hide Column
g£0-1000C:007 E& )
B Reset to Fackory Settings 40.0
1.80-10000-001 Calumns 400
1 80-10000-001 Propetties 100

<l it

1 Change the column order by clicking the column header in the browse screen and dragging it

to another position in the results list.

2 Adjust the column size by clicking on the border of the column header and dragging that

border to the left or the right.

3 Click the column header to sort all datain the result list on any of the columns. Click the

header again to sort the datain reverse order.

4 Each column header also features a drop-down filter option when all data has been retrieved.

Click theicon to display the available filters
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Managing Filter Fields

Managing Filter Fields

Supplier Invoice Browse for Vi X

Actions 7 lgl Print | Addto Favorites | (g 3 %@ Chart Designer | & Refresh Stored Searches
Search [14]
[Upen | [eguat T |1 ™l Gl
IciceDae  v|[eask || =) - | A+ x
E Supplier Invoice Browse for View - Manage Filter Fields
Label 4 Vigible & Operatar 4 FirstInitial Walue 4 Second Initial Yalue 4

Supplier Code Il equals

Business Felation ¥ equals

Reference v equals

Year Il equals

Dapbook Code vl equals

“oucher I equals

Posting D ate Il equals

v
Invoice Date v equals
Invaice Status Ca vl equals

This option displays all the search fields possible for this type of record. You can use the Manage
Filter Fields tab to:

- Specify whether afilter field should appear on the Selection Criteriatab (Visible column).
« Specify in which order the filter fields should appear.
» Specify what operator to use when finding data to view.

- Define apersistent initial value or range of values for the filter field. The values for search
criteria entered in the actual Search Panel are not saved with the stored search. However, the
initial values entered in Manage Filter Fields are saved.

 You can refine the default search for GL accountsto retrieve only accounts with codes that are
within a number range of 1000 to 5000.
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Reporis

J Default Davbook Browse % |F{epurt - Default Daybook Brow .. |

Actions '-I.E,',J Print ° © Add to Favorites I g Chart ﬁ? Chart Deszign
Exportto 5
Export to Excel Filter |; ;
t Exportto PFDF 1& Print | =] _:-‘-‘: # Refrash B B
D workflow CE0OB @ @ Pae1 ® @& 5245 &%
L E-mail
B Report
Ic n Default Daybook Browse
I QAD QmsUs USD
IC
Transaction Type Documert Type From Ertity To Entity Daybook
ek e— SSYEDB
Ic ICDEFDE
Ic CETADJ std cost
Ic |1S5-PRY I1S5-PRY
Ic 155-50 158-50
Ic |1S5-UNF IS5-UHP
Ic 12500 nolss
I WATL AR W ONRAR
IC RCT-FO RCT-FO

The Actions menu for Browses includes the options to Export to CSV, Excel, or PDF, and

to generate areport from the browse results.
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Quick Search

Quick Search

a h
| cantaing = = | [Stats'with = D|
Starts 'With 4y i
equals g Fsbr031.p £ B
containg 38 CE Installed Baze Browse [ [
=g Sales order and items [ Defaul Daybook Browse
[ [Gales Didet Browse | B¢ Sales Browses | £

S Mtem Browse [ Salesperson Browse :
[ Sales Quoate Bill Browse <

<[ Sales Quote Browse

B ltems

B © Customer

<[ Customer ltem Browse

[ Sales by Customner Browse
E S/R0 by Custamer Browse

[ Customer Browse

Er Salez by Customer Browse

B Evering Customer Browse

Search for avalue across all of the fields in the browse.

Usethe * Search For option from the Search pull-down list to retrieve all the resultsthat contain the
search value in any of the columns. You can use thisfilter for all browses.Use the Contains, Starts
With, or Equals operators with the Search For filter. This option searches integers and text strings
only and does not retrieve dates. Available on the | eft-hand side of the panel

Create groups of browses for quick search purposes. By default, the browse groups area of the
panel is empty. Create a new browse group by right-clicking on the panel and selecting New to
create a new browse folder. Add individual browses or browse collections by selecting the folder
and dragging and dropping browses from the Applications panel. Enter a search term in the Quick
Search field and press Enter to search the browses contained in the folder for the term.
Performance is affected when the browses have many fields with underlying joins.
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Operational Metrics

Operational Metrics

I Accounts Receivable X|
‘ = Refresh = Print - % Print Praview New # Edit= ¢ AddtoFavorites |k Save 3£ Delete
|—| Customer Credit Limits @)
; -
: F Name Result Total
=7 Metrics L 2

- [@ Accounts Recsivable E Zero Credit Limit 18 T 7|° ww 155
i B Accounts Receivable Analytics
i (/] 20 40 60 80 100
[ Addresses Negative Credit Limit 0 1 %@

B AP Operations

| : O 220 4 & 8 100 )
[ AR Dperations 0 U9 i I— o=@
[ Banking/GL . o 0 B 4 @ @ w0
; B Configurator Model Completenes i ls [ S TR— —y 100% @

B Configurator Operational Perfor
H B Configurator Rules Completenes

B Customer Data .
B DRP Total (Customer Credit Limits)

B Inwventory Metrics
H B Irwentory Turns
B Item ABC Code Metrics

S S S |4 q
\LI—IHI—l |L| Total (Accounts Receivable) &

The Browse Operational Metrics option lets you create a visible metric from browse data.
Operational metrics provide you with alive snapshot of production data, which lets you monitor in
real-time how the system is being used. You can use operational metrics to visually track any type
of browse data, including data from customized browses created in Browse Maintenance. xcel
Integration

There are a number of pre-defined metrics that can be accessed under the Metrics folder. In this
case, the Accounts Receivable metric displays different customer metric results.
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Creating an Operational Metric

Create Metric Collection

[Untltled x}
e Refresh &) Stop (=0 Print » Print Preview | | | New ¢ Edit | ' AddtoFavorites | [ Save 3£ Delete
Untitled

Total (Untitled) |

Title | § Customers By Ste
Untitled

» Select Create Metric Collection from the Administration menu to create the initial metric
collection. The system prompts you to name the collection.

» Right-click the collection title, or select Edit|Create Metric Group to create a metric group for
the collection. You are prompted to select the parent browse for the group. Double-click the
name of the browse to select it.
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- -
Edit, Create Metric Group

* | Create Metric Group = E|_
¢+ Actions ~ @J Print
Search 6
T — PE)-| |+ x
Viewing 1-100 of 1313 Records perpage: [100 +| @ @ @ @ J
Name »  Description View % PowerBrowse Look-up Browse Sort Columns DOrag Back Column UserlD K
| 45999 45999 __wwds399 Yes Yes D mfg i

7r987 Dock Addresses _ wwir3sT Yes Yes 0 mfg

78199 75199 __wwiis189 Yes Yes 0 mfg

aad39 AASSY _ wwaa¥99 Yes Yes 0 mfg

ab001 Customer Order Processing __wwabD01 Yes Mo 0 emb

ad001 Customers cmmstrQ1 Yes Mo 2 jpm

ad00s Dock Addresses admstrD& Yes Mo 2 mfg

ad006 Employees emp_mstr Yes Yes 2 kbh

ad007 End User Addresses __wwad007 Yes Yes 0 mfg

ad00g Address List Types __wwad00g Yes Yes 0 emb

adl10 Salespersons spmstrl1 Yes Mo 2 jpm

ad011 Commission Detail spmstrl2 Yes Mo 2 lkbh

ad014 Suppliers vdmstrQ1 Yes Mo 2 jpm

ad015 Country Codes ctry_mstr es No 2 kbh [
[ il | [ie

Enter aname for the metric group (for example, Customers by Site) and click OK. Select abrowse

on which to base the first metric.

MNQAD



104  Training Guide — QAD .NET Ul

Creating an Operational Metric

Creating an Operational Metric

=

Tite | Cusiomers at sie 10000

o 1m0

i —— Sl
Type | Conl | [ | |Fewcent - 1~ 00

&)

Search[1]

|5i|c Z |cq_|°h - |\E|D:IEI ‘.-_‘.,| i | + x [ _san 1| [ ciearan |

i Cancel

Title. Enter atitle for the metric (for example, Customers at site 10000).

Type. The default typeis Count. When you select the Count type, the browse filter drop-down
is unavailable. Type options depend on the type of browse. For browses that produce

numerical values asresults, you can also choose Sum, Average, Maximum, or Minimum asthe
Type option. When you select atype other than Count, you can then select the value to which

you apply the type.

Percent/Range. Select Percent to display the metric as a percentage of the browse total.Select
Range to display the metric as arange of figures. This option lets you increase the granularity
of the results.

Search. Select the browse filter, operator, and value to define the metric. For example, this
metric is based on the number of customers in Customer browse whose site code equals
10000. You therefore select the site code filter to equal 10000. You can set multiple filters for
the metric, as you do on anormal browse. Click Search to find out how many sites meet the
criteria (in this case, the number is 33). Thisinformation is displayed as a percentage of the
total (when you have selected the Percent display option). Use the dlider controls on the
percentage bar to set the color code for thresholds.
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Edit Operational Metric

Gustcmer Details =

2 Rsfresh 0 2rim X PrirtPreview | | Wew g Edit | [ scdtoFavaries b Save 3 Do

=tamer Netails

Cuslirm s by Sile

Harna
Custamers =t sit= 13000

Custamers ot sits 12000

Custorrers at sike ZM1I00
-1

Rasult Totzl
- gy Md W w cw
ey | | |
[T T TR TR TR
5 I )
[T TR TR TR TR T
o 13— | —

Tctal (Custowress by 5 ted .
otal {Custcrrer Liatails) .

9t dp

Pl
indp

You can edit metric details by right-clicking the metric name on the main screen and selecting
Edit. Click on the Save button to save the operational metric to the Metrics folder, New to save the
metric for the first time, and Replace to replace an existing metric. The metric is now availablein
the Metricsfolder. You can add operational metricsto Favorites. To refresh the metric information,
re-run the individual browses from within their metrics.
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Creating Excel Output From Browses

Excel Integration

Loading Data for Export to Excel for Maintenance

The Load opftion lets you retfrieve all the records from the
database and export them 1o Excel for maintenance.
Choose the Excel Integration activity from the menu and
load data into the grid using the Load option (right-click
the empty grid to selectlLoad).

Export the data to a spreadsheet, open the data in Excel,
and modity it.

Right-click the grid again to select Exportto Excel.
Save your changes.

Import the modified data (right-click the empty grid to
selectimport from Excel, and click Save to create or
update the data in the system database).

Click the Actions Tab and Export to Excel button.

The export creates three worksheets in an Excel workbook, which is opened for display.
 Data. This page contains the actual data columns and headings from the printed browse.

» Search Conditions. This page displays any search conditions used to filter the printed data. The
conditions listed are field name, operator, value, and, for a range operation, the ending value.

« Info. This page lists details about the report generation including the ID of the user generating
the report, the date the report was generated, the name of the browse, and the browse program.
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Excel Integration

Excel Integration

Country Excel Integration

L] 2 Actions ¥ % Tools = '_,"_:j’,! Print & Preview:

Attachments

Country ¢ Description ¢ Active ¢ Postal Format 4 EU ¢ B

Exportto Excel
Expand All
Collapse All
Columns..
Reszetto Initial Settings
Print... 3
Load Countries
E=portto Excel for Maintenance
Import from Excel

Excel integration is a utility for component-based programs that lets you export datainto Excel
spreadsheets, create new data within Excel, and import it to the system database, whereitis
validated before being saved.

Note The more advanced bi-directional Excel integration is supported in only a subset of
components.

This activity has multiple steps:

Choose the Excel Integration activity such as Country Excel Integration.

Load datainto the grid using the Load option (right-click the empty grid to select Load). The
Load option lets you retrieve al database records for a supported business component.

Export the data to a spreadsheet, open the datain Excel, and modify it (right-click the grid
again to select Export to Excédl).

Save the Excel filein afolder that can be accessed so that the Excel sheet can be modified.

Modify the Excel file and save for import. Right click on the maintenance screen and select
Import From Excel.

Import the modified data (right-click the empty grid to select Import from Excel, and click
Saveto create or update the data in the system database).

Notice the changes that were made.
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Chart Designer

Chart Designer

+ Generate graphicalrepresentations of browse
catfia.

+ Toggle between the standard browse display
(called the grid view) and the new chart view.

« Use the chart view editor to select data in a browse
and display the data as a pie chart or bar graph,

[SRerowse chart Designes X
for example. S carcoeome
doadis Label: [OERE Chart Title:

*-Variable: |Sold-To |Sales Order Browse
Chart Type: | Pie Chat

-Auis Label: [Item Number
Group By X Values: & Tes
T-Variables: € No

Item Number - Count

Preview Chart |

[ aesly | [ cancel

Generate graphical representations of browse data.

Toggle between the standard browse display (called the grid view) and the new chart view.

Usethe chart view editor to select datain abrowse and display the data as a pie chart or bar graph,
for example.
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Using The Chart Designer

Creating Charts from Browses

| . Start a browse and click on the Chart
Designer icon.

2. Design a chart using the Browse Chart
Designer.

- Set X- and Y-Axis
labels

- Set X and Y variables
- Group By X Values

- Chart Title

- Chart Type

- Preview

Browse Chart Designer
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Chart Options

Chart Options

« Rotate and Zoom 3D Charts
- Search Charts
« Hide Titles and Legends
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Chart Options

Chart Options

« Launch Chart in New Window.
« Copy Chart to Clipboard
« Edit Chart Design

Interactive Charting

- For any item that has a drill-down, a split-screen
view of both the chart and the drill-down browse,
which can also be displayed as a chart.

- Click anitem in the first chart, tfo automatically
change the view to reflect the changed data for
the drill-down. Click an item in the chart to select
the associated row in the browse. Conversely,
click arow in a browse to select the associated
item inthe chart
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Summary

Summary

Browses let you to display selected data in
different formats. You can also display
browse data as charts or as operationadl
metrics. Operational metrics can be used to
display operational deficiencies in real time.
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Exercise and Knowledge Check

1

Open up the Sales Order Browse. Highlight any Sales Order and drill down by double-clicking
a Sales Order number. In the Sales Order Maintenance screen that appears, click the Sold-To
lookup.

Go to Supplier Invoice View and display a component-based browse.

Use Sales Order Browse and limit the output of the Sales Order Browse to orders for one
specific customer.

What was the filter did you use? What operator did you use? Send the output to an Excel sheet.
From the Metrics folder, display the Accounts Receivable metric.

Run Excdl Integration for Country Browse. Delete a country and re-import the Excel sheet.
Run Sales Order Browse and rearrange the columns. Group the results by Sold-To.

Use Chart Designer to create a chart for Item Master Browse.

Label the x axis Product Line and select the variable prod line.

Label the y axislabel Part Number and select the variable item number and group by count.
Select a 3D pie chart and run the chart.
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Chapter 6

Using Character in the .NET Ul
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Chapter Objectives

Chapter Objectives

+ The objective of this chapter is to infroduce
the functionality of Character mode.
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Chapter Benefits

Chapter Benefits

« The user will be able to use and navigate
the character version of QAD Enterprise
Applications.
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Introduction to the Character Ul

Infroduction to Character

- Character user interface depends on input
from the keyboard.

- A command-prompt interface to execute
programs

- Combinations of keystrokes to issue commands
withinprograms

- Navigationwithout use of a mouse through the
UNIX character interface
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Training Flow

Training Flow

Infroduction
Navigation

« Application Help

« Program Types
Browses

- Character Version
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Character Login Screen

Character Login Screen

£P172.16.28.81 - PuTTY M=%
[~

b i R cR A S TS TORE MR o Y | RS R R pR e
QLD Enterprise Applications 2010 - Enterprise Edition as of Feb 24 2010
QAD
100 Innovation Place
Santa Barbara, CAL 93108

{B05) 6E4-6614
{805) 565-4202 FAX

Copyright 1986-2009 QAD Inc. All rights reserved.
This product may nhot be reproduced or distributed
Letive Users: Defined Tsers:

Password:
Domain:

User ID: . ‘

Enter data or press F4 to end. |w

To start acharacter session, follow the procedures provided by your system administrator. Thefirst
screen you see after launching the system lets you log in to the system. Enter the login ID assigned
by your system administrator and your password. If you have been given access to more than one
domain inthe system, enter its name in the Domain field. If you have access to only one domain,
this domain displays in read-only mode. You must be avalid user to log in. Your password can be
blank only if the password in your user record is blank.
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Main Menu Character Mode

Main Menu Character Mode

#P172.16.28.81 - PuTTY =Jo)ed
QME US : gaddb -~
‘mfmenu Main Menu osszef 10‘
1. Items/Sites 13. Product Structures 25, General Ledger
Z. Addresses 14. Routings/Work Center 26. Multiple Currency
3. Inventory Control 15. Formula/Process 27. Accountz Receivable
4, Warehousing 16, Work Orders 28, Accounts Payable
5. FPurchasing 17. Lean Manufacturing 29, Tax Management
£ 15. Repetitive 30. Cost Management
7. Sales Orders/Invoice 19, Quality Management 31. Banking/Cash Momt
8. Configured PFroducts 20, Product Line Flan 32. Fixed Assets
9. 21. Resource Flan 33. Enterprise Ops Flan
10 22. Forecast/Master Plan 34.
11. Service/Support 23. Materials Regpts Plan  35. EDI eCommerce
12, Distribucion Plan 24, Capacity Repots Plan 36, System Admin
Please select a function. F4 or blank to EXIT [
Press FZ for Help |

MFG/PRO has locations for 36 modules on the character-based Main Menu. In turn, each module
has one or more menus attached to it. Menus are lists of programs you use to look up or input
data. The menus that you will see depend on the security access that has been granted to your role.
Only menus with programs that you have access to display. When you enter amenu number on the
command line, the system either executes aprogram or displays alower-level menu. You can keep
drilling down through the menus until you reach the appropriate level. Alternatively, you can
access a program directly by entering its Progress name—such as ppptmt . p for Item Master
Maintenance—or number at the command prompt.

If the current menu displayed is System Admin (36), you can enter 24.1 to access Database
Control (36.24.1). However, you must enter.1.4.1 to run Item Master Maintenance (1.1.4) because
it ison adifferent submenu.

You can also use the arrow keys to move around the menu, then press Enter to execute the
highlighted selection.
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Menu Substitution

Menu Substitution

£ 172.16.28.81 - PuTTY (=<

ucnsSmt . B 3+

New Execution File: frmmaig.p
Selection Label Term: FORMULA CODE INQUIRY
Formula Code Inguircy

Fl=Go 2Z=Hlp 3=In=s 4=End &=Mnu 7=Rcl 5=Clr 9=Prev 10=Next 11=Buf |;

Menu substitution lets you toggle between displaying browses and inquiries on the menu. You can
also useit to switch between customized and non-customized versions of a program. The system
administrator can use Menu Substitution Maintenance (36.4.4.7) to specify which programs are
substituted for others when you select this option. By default menu substitution is disabled. It can
be enabled for individual usersin User Maintenance (36.3.1).
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Program Screen Elements

Program Screen Elements

P 172.16.28.81 - PuTTY

Tifle bar = p 3+ 7.1.1 Sales Order Maintenance
i Purchase Order: !OSl Supplier: 505800 Ship-To: US-W-S ‘
Supplier Ship To
Sandwich Factory us-w-3
PngrOm = Storey Street 530 1 California Boulevard
Window
Vickery COH OH43454 San Diego Ch 92104
UNITED STATES UMITED STATES
Order Date: 07/08/07 Price Tbl: Confirming: Yes Imp/Exp: No
Due Date: 07/08/07 Disc Thl: Currency: USD Language: us
Buyer: Ln Disc: 0.00 Taxable: No H
bata —— Bill To: US-U-5 Site: US-¥-5  Fixed Price: Yes Consign: No
Frarne Sales/Job: Daybook Set: Def AP  Credit Terms: 2N 0.00
Contract: Project: Entered By: lvh
Contact: Requested By:
Remarks: Comments: No
Progress
Status Bar F1=Go 2=Hlp 3=Ins 4=End 6=Mnu 7=Rcl 5=Clr 9=Prev 10=Next 11=Buf

Thetitle bar identifies the program currently running. What displaysin the title bar depends on the
Header Display Mode setting in Security Control (36.3.24). Based on that setting, you may see any
of the following elements:

« « Thetitle bar includes—from left to right—the program name, the version of the program, the
menu number and title, and the currentdate.

* The Progress program name, such as sosomt.p

» * The program version, such as 99
» +» The menu number and title, such as 7.1.1 Sales OrderMaintenance
» « The current date

Program Window
 The program window displays the frames and fields of the current program.

Progress Status Bar

» The status bar shows the basic commands needed to navigate through the specific program
currently displayed in the program window.
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Character Browse

Character Browse

P 172.16.28.150 - PuTTY N =
i R e TS |
User Menu Edit Options Help Type mn [l
05/26/10
Type Description /26!
Trans Type:[|_ >FA Fixed lssets
Trans Type Doc Type From Ic Inventory Control ook
30 Sales Orders
5 W Work Orders SDEB
1c FLE
Ic CET-ADJ cost
Ic ISS-PRV PRV
I1c I155-80 =1s]
1c 155-UNF UNF
I1c I55-wo WOISS
ic MATL-VAR WOMVAR
1c RCT-FO RCT-FQ
1C RCT-S50R RCT-S0OR
Filter = Off
Fi=Go z=Help 3=Ins 4=End 6=Menu 7=Rcl B=Clr 1ll=Faste ™

Using Browses in Character Ul Browses display selected datain the form of atable. Browsesin
the character Ul are similar to thosein the .NET UlI, but have a simpler set of features. Two types
of browses are available:

» Look-up browses return the value you select to the active field in the calling program.
« Drill-down browses display, filter, or print data.
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Browse Menu Bar

Browse Menu Bar

Defined in I ) )
User Function  e2172.16.28.150 - PuTTY E]g
rainfenance Edit Options Help 1
Default Daybook Browse 0s/z6/ 10‘
Princ CTEL-F
Standard
Menu Run Program... CTRL-R Entitcy To Entity Daybook
Mantenance Baib  Eaten .
— USSYSDE
Ic ICDEFLE
Ic C3T-ADJ std cost
Ic ISS-FRV He 1)
Ic  |I3s-so |
Ic I35-TNFP [FOnTENCS
IC IS3-W0 /| Interface Help
Ic MATL-VAR
Ic RCT-PO Field Help
Ic RCT-S0OR FProcedure Help SHIFT-F1
‘| brill-Down E3C-TLE
Filter = OQOff Look-up Browse F2Z
About. .. CTRL-F1 !5
i

To scroll through the records, use the Up and Down arrows.

The User Menu in the browse menu bar differs from the User Menu accessed by pressing F6. The
User Menu in the browse menu bar provides access to:

User Menu ltems

Print Options

Run Program

Exit

Edit

Cutting text deletes it from its current location and copies it to the clipboard. Copying is similar,
but it leavesthe original text in place. In both cases, you can paste the text to another location, such
asafield.

Choose the text to cut or copy.

Display the Edit menu.

This menu choice is available only when text is selected.
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 Choose Cut or Copy.
« Position the cursor in the new location.

- Display

Options

Use this option to set up filter criteriafor browses. The filter criterialimit the viewable records
according to your specifications. For example, you can filter out product numbers or statuses that
you do not want to view.

- Toggle Filter :Use the toggle filter setting to turnturn on and off the filter criteria set up inthe
browse filter options.

Help

The fastest way to get help for the current field is by pressing F2 twice, press F2 once and, if
available, alookup browse displays), but you can also bring it up with the Help menu. With the
cursor in the field, drop down the Help menu and choose Field Help and procedure help.

Output Devices

You can send the output from reports, inquiries, and browses to a numberof devices, including the
following:

* Your terminal
A server printer
« An e-mail message

However, the character user interface does not offer as many options asthe QAD .NET Ul. You
can send output to Terminal or page, but not to Window. If you select Window, the system displays
an error message. The Winprint option is designed only for Windows clients. If you select this
option, the system displays an error message. Otherwise, the output options are the same in both
interfaces. If you select a printer as the output device, be sure to use one that has been definedwith
adestination type of Default in Printer Setup Maintenance(36.13.2). Just asin the QAD .NET UlI,
you cannot use e-mail unlessit has been setup properly.
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Chapter Summary

Summary

« The use of character is still an opftion.

« Used mainly for highly repetitive heads-down operator
fransactions.
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Exercise

Isthe .NET Ul or the character version a better option for your company? Why Or why not?

Go to the sold-to field in Sales order maintenace and pull up the drill down browse, field help ans
procedure help. What key or keys did you hit?
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